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1760 Power Quality Recorder 

Einführung 
Dieses Einleitungshandbuch für den Fluke 1760 Power 
Quality Recorder, im Folgenden als "Recorder" 
bezeichnet, hilft Ihnen bei der Einrichtung und 
Durchführung verschiedener Netzqualitätsmessungen. 
Die Anleitung ist eine gekürzte Fassung des 
Bedienungshandbuchs und weiterer auf der CD-ROM 
mitgelieferter Materialien. 

Sicherheitsinformationen 
Diesen Abschnitt sorgfältig durchlesen. Hier werden die 
wichtigen Sicherheitsanweisungen für die 
Gerätebedienung des 1760 Power Quality Recorders 
erläutert. Ein Warnhinweis in diesem Handbuch 
identifiziert Bedingungen und Aktivitäten, die den 
Bediener möglichen Gefahren aussetzen. In einem 
Hinweis werden Bedingungen und Aktivitäten 
beschrieben, die den Recorder beschädigen können. 

Sicherheitsanleitungen 
Die Konzipierung und Herstellung des Geräts stimmen 
mit dem neuesten Stand der Technologie und den in 
EN/IEC 61010-1:2001 (2. Ausgabe) spezifizierten 
Sicherheitsstandards überein. Bei nicht sachgemäßer 
Verwendung besteht die Gefahr von Sachschäden und 
Verletzungen. 

Schutzklasse 
Dieses Gerät entspricht gemäß IEC 61140 Schutzklasse I 
und ist mit einem Schutzleiteranschluss ausgestattet. 

Symbole 
Tabelle 1 stellt die Symbole auf dem Instrument und/oder 
im dazugehörigen Handbuch dar. 
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Tabelle 1. Symbole 

Symbol Beschreibung 

X Gefährliche Spannungen. Risiko von 
Stromschlägen. 

W Wichtige Informationen. Siehe Handbuch. 

- Nicht in der Nähe von GEFÄHRLICHEN 
SPANNUNGSFÜHRENDEN Leitern 
anwenden oder davon entfernen. 

J Erde. 

T Doppelte Isolierung. 

B Wechselstrom (AC – Alternating Current). 

F Gleichstrom (DC – Direct Current). 

P Konformität mit den EU-Anforderungen. 

) Die Canadian Standards Association ist 
die Zertifizierungsstelle für 
Übereinstimmungsprüfung bezüglich 
Sicherheitsstandards. 

~ Dieses Produkt nicht mit dem Hausmüll 
entsorgen. Recycling-Informationen sind 
auf der Website von Fluke zu finden. 

; Übereinstimmung mit den relevanten 
australischen Standards. 

CAT II 

 

IEC-
Überspannungskategorie/Messungskatego
rie II-Ausrüstung ist so konzipiert, dass sie 
vor impulsförmigen Störsignalen aus 
Steckdosen und ähnlichen Punkten 
schützt. 

CAT III IEC-Überspannungskategorie III-
Ausrüstung ist so konzipiert, dass sie vor 
impulsförmigen Störsignalen in Anlagen 
wie z. B. Verteilertafeln, Zuleitungen und 
kurzen Verzweigungsstromkreisen und 
Beleuchtungssystemen in großen 
Gebäuden schützt. 

CAT IV IEC-Überspannungskategorie IV-
Ausrüstung ist so konzipiert, dass sie vor 
Spannungsspitzen der 
Primärversorgungsebene (z. B. 
Elektrizitätszähler oder Freileitungs- oder 
Erdleitungsversorgungssysteme) schützt. 
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CAT-Identifikation 
Abb. 1 stellt die Positionen der verschiedenen 
Messungskategorien anhand eines Beispiels dar. 

 
emv01.wmf 

Abbildung. 1. CAT 

Fachpersonal 
Angemessene Qualifikationen umfassen Folgendes: 

• Ausgebildet und befugt, die 
Stromverteilungsschaltkreise und Geräte gemäß 
Sicherheitsstandards der Elektrotechnik ein-
/auszuschalten, zu erden und zu kennzeichnen. 

• Schulung/Anweisung in Übereinstimmung mit den 
Standards der Sicherheitstechnik in Wartung und 
Gebrauch angemessener Sicherheitsausrüstung. 

• Schulung in Erster Hilfe. 

Sicherer Betrieb 
Zur sicheren Verwendung des Recorders: 

• Sicherstellen, dass alle Bediener des Geräts das 
Bedienungshandbuch und die 
Sicherheitsanweisungen vollständig gelesen und 
verstanden haben. 

• Das Gerät kann nur unter bestimmten 
Umgebungsbedingungen verwendet werden. 
Sicherstellen, dass die tatsächlichen Bedingungen 
den zulässigen Bedingungen entsprechen, wie sie in 
den technischen Daten des Bedienungshandbuchs 
beschriebenen sind 

• Während der Inbetriebnahme sicherstellen, dass eine 
ausreichende Luftzirkulation um das Instrument 
gegeben ist, um die Stauung von Wärme im Gehäuse 
zu vermeiden. 

• Beim Verpacken und Transportieren des Recorders 
das Kapitel "Transport und Lagerung" des 
Bedienungshandbuchs befolgen. 
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Hinweis 

Das Gerät nur zur Messung von Spannungen 
und Strömen verwenden, die innerhalb der 
angegebenen Bereiche und Messkategorien 
liegen, einschließlich Spannung gegen Erde. Die 
genauen Spezifikationen lesen Sie im 
Benutzerhandbuch nach. 

Bei unsachgemäßer Verwendung verfällt jegliche 
Garantie. 

Elektrische Anschlüsse 
Sicherstellen, dass der Schutzleiteranschluss der 
Stromleitung und der Gehäuseerdanschluss 
vorschriftsgemäß an das Massekabel mit geringem 
Widerstand angeschlossen sind. 

Sicherstellen, dass sich die Stromversorgung und die am 
Gerät angeschlossenen Kabel sowie auch alle mit dem 
Gerät verwendeten Zubehörartikel in betriebsfähigem und 
sauberem Zustand befinden. 

Das Gerät so installieren, dass das Stromkabel jederzeit 
zugänglich ist und mühelos getrennt werden kann. Wenn 
dies nicht möglich ist, muss ein zweipoliger 
Leistungsschalter mit Nennstrom in den Stromleitungen 
installiert sein. 

Bei Anschlussarbeiten nicht alleine, mindestens zu zweit 
arbeiten. 

Das Gerät nicht verwenden, wenn das Gehäuse oder ein 
Betriebselement beschädigt ist. 

Sicherheitsanleitungen 

XW Warnung 
Durch den Anschluss des Recorders an 
stromführende Messkreise gelangen gefährliche 
Spannungen an die Anschlussklemmen und ins 
Geräteinnere. Die Verwendung von Messleitungen 
und Zubehörprodukten, die die relevanten 
Sicherheitsstandards nicht erfüllen, kann zu 
schweren Verletzungen oder Tod durch 
Stromschlag führen. 
Zur Vermeidung von Stromschlag oder 
Verletzungen sind folgende Vorschriften zu 
beachten: 
• Der Power Recorder darf nur durch 

Fachpersonal bedient werden. 
• Wartungsarbeiten dürfen nur durch 

Fachpersonal durchgeführt werden. 
• Erst das Gerät über den Netzstecker mit 

Schutzerde und dem Versorgungsnetz 
verbinden. 

• Nur vorschriftsmäßige Spannungs- und 
Stromzangen verwenden. Wenn flexible 
Stromsensoren verwendet werden, 
Schutzhandschuhe tragen oder mit 
stromlosen Leitern arbeiten. 
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• Den Recorder gegen Nässe und Feuchtigkeit 
schützen. 

• Die Stromzange nicht vor dem Griffschutz 
halten.  

• Um Stromschlag zu vermeiden, die 
Strommessleitungen stets vor Anschließen 
an die Last an den Recorder anschließen. 

• Um Stromschlag zu vermeiden, die 
Spannungsmess- oder 
Stromversorgungseingänge nicht an Anlagen 
mit höherer Spannung gegen Erde als auf 
dem Recorder angegeben anschließen. 

• Um Schäden am Recorder zu vermeiden, 
niemals die Spannungsmesseingänge an 
verkettete Spannungen anschließen, die den 
spezifizierten maximalen Spannungswert der 
Spannungssensoren überschreiten.  

• Stellen Sie vor Anschluss der Messkreise 
sicher, dass die maximale Messspannung 
und die maximale Spannung gegen Erde den 
auf dem Spannungssensor angegebene 
Spannungspegel nicht überschreiten, und die 
Kategorie des Verteilersystems der Aufschrift 
des Sensors entspricht oder die 
landesspezifischen Normen erfüllt. 

• Ausschließlich das gelieferte Originalzubehör 
oder spezifiziertes Zubehör verwenden. 

• Dieses Zubehör nur in den definierten Mess-
Überspannungskategorien verwenden. 

• Stromtransformatoren und/oder Flexi-probes 
sollten nur unter Verwendung von 
Hochspannungshandschuhen an 
stromführende Leiter angeschlossen oder 
davon entfernt werden.  

• Die Stromversorgungsanschlüsse der 
Energieversorger der Stromzähler werden als 
CAT IV-Bereich betrachtet. Der Recorder darf 
niemals an diesen Anschlüssen versorgt 
werden, um Stromschläge oder Schäden an 
der Ausrüstung zu vermeiden. 

• Verwenden Sie die flexiblen Stromzangen nur 
bei 600 Vrms/1000 Vrms, je nach 
Installationskategorie oder spannung gegen 
Erde. 

• Verwenden Sie die Zangen nur an isolierten 
Leitern. 

• Zusätzliche von lokalen Regierungsbehörden 
vorgeschriebene persönliche 
Schutzmaßnahmen sind erforderlich, wenn 
die Messsensoren an stromführenden Leitern 
installiert sind. 

• Gleichphasigen Anschluss an mehreren 
Kanälen vermeiden. 
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Zubehör 
Ausschließlich mit dem Gerät geliefertes oder speziell als 
Option für das verwendete Modell konzipiertes Zubehör 
verwenden. 

Sicherstellen, dass Zubehör von Drittherstellern gemäß 
IEC 61010-031/-2-032-Standard in Verbindung mit dem 
Gerät verwendet wird und für den jeweiligen 
Spannungsmessbereich geeignet ist. 

Gefahren bei der Bedienung 
Sicherstellen, dass die angeschlossenen Geräte korrekt 
funktionieren. 

Messsensoren dürfen nicht an ungesicherte Schaltkreise 
angeschlossen werden. 

Verbindungsstecker mit Verschlussmechanismus müssen 
fest verschlossen sein. 

Gerätabschaltung 
Wenn Beschädigung an Gehäuse, Bedienelementen, 
Steuerelementen, Netzkabel, angeschlossenen 
Messleitungen oder angeschlossenen Geräten festgestellt 
wird, die Messeingänge unverzüglich von der Einheit und 
der Stromversorgung trennen. 

Wenn Zweifel hinsichtlich der Betriebssicherheit des 
Geräts bestehen, die Einheit und das jeweilige Zubehör 
unverzüglich abschalten, sicherstellen, dass die Geräte 
nicht versehentlich eingeschaltet werden, und das 
verdächtige Gerät an ein Servicezentrum einsenden. 

Sicherheitsbestimmung für Gerätegehäuse 
Der Netzanschluss muss den Messbereichen/Angaben 
auf den Geräteaufklebern entsprechen. 

 
emv02.wmf 

Abbildung. 2. Geräteaufkleber 
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Abbildung. 3. Akkuaufkleber 

XW Warnung 
Netzkabel des Geräts nur an 
Versorgungsspannungen der Messkategorie 
CAT I, II oder III anschließen (Details dazu im 
Abschnitt Identifikationen). Spannung gegen 
Erde darf 300 V nicht überschreiten. 

Eingangsspannung – Messeingänge 
Die Messkategorie (siehe Abschnitt "Identifikationen") und 
die maximale Spannung gegen Erde der Sensoren 
müssen mit dem Stromnetz kompatibel sein. Siehe 
Abschnitte "Beschriftung" und "Technische 
Spezifikationen". 

Schutz 
IP40  

Vor der Verwendung des Recorders 
Vor der Verwendung des Recorders Verpackung und 
Inhalt sorgfältig auf Schäden prüfen.  

Hinweis 

Abhängig von der bestellten Konfiguration sind 
flexible Stromzangen und Spannungssensoren 
eventuell nicht im Standardlieferumfang enthalten. 
Eine integrierte Transientenerfassungsoption (nur 
vorinstalliert) ist ebenfalls eine Konfiguration, die 
bei der Bestellung festgelegt wird. 
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Prüfen Sie vor der Inbetriebnahme des Geräts anhand der 
folgenden Liste und der Lieferspezifikationen, ob die 
Lieferung vollständig ist. 

Fluke 1760 Basis-Modelle (einschließlich Basic TR):  

• 1 Power Quality Recorder-Gerät 

• Transporttasche 

• 1 Netzkabel für Netzanschluss 

• 1 Adapterset für Netzanschluss 

• Einleitungshandbuch 

• CD-ROM mit PQ Analyze-Anwendungssoftware, 
Handbüchern, Datenblättern und Demodaten 

• 1 gekreuztes Ethernetkabel für direkte PC-
Verbindung (graues Kabel mit roten RJ45-Steckern) 

• 1 Ethernetkabel für Netzwerkanschluss (graues Kabel) 

• 1 RS232-Nullmodemkabel (rotes Kabel) 

Sonstige Fluke 1760-Modelle (einschließlich INTL-Modelle, 
US-Modelle und TR-Versionen) 

• Spannungssensoren und flexible Stromsensoren 

• GPS-Zeitsynchronisationsempfänger 

Verwendung des Recorders 
Der Recorder misst Variablen in der Netzqualität; die 
aufgezeichneten Daten werden mit PQ Analyze-Software 
analysiert, die auf der CD-ROM mitgeliefert ist. Dieses 
Handbuch leitet Sie durch die Installation der Software, 
den Anschluss eines Recorders an das Stromnetz und 
den Beginn einer Datenanalyse. 
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PQ Analyze-Schnellinstallation 
Legen Sie die PQ Analyze-CD in das CD-ROM-Laufwerk 
Ihres Windows-PCs ein (die Systemanforderungen 
entnehmen Sie dem 1760 Referenzhandbuch). Sollte die 
Anwendung nicht automatisch starten, führen Sie das 
Programm "launch.exe" von der CD aus. 

Wählen Sie "PQ Analyze-Software installieren" (Install PQ 
Analyze Software) aus dem CD-ROM-Menü aus und 
befolgen Sie die Installationsanweisungen. 

 

 
emv04.jpg 
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Starten von PQ Analyze 
Nachdem die Software installiert wurde, starten Sie PQ 
Analyze über das Startmenü. 

 
g_emv05.bmp 

Beim ersten Start von PQ Analyze werden Sie 
aufgefordert, Ihre "Default Def-Datei" (Default Def-File) 
auszuwählen. Dabei handelt es sich um eine 
Konfigurationsvorlage mit regionsspezifischen 
Standardwerten. Wählen Sie die Region aus, die Ihrem 
Standort am nächsten liegt. Sie können diese Einstellung 
jederzeit über das Menü "Optionen > Default Def-Datei" 
(Options > Default Def-File) ändern. 

 
g_2.bmp 
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Mit Demodaten arbeiten 
Bevor Sie den Recorder anschließen und echte Daten 
herunterladen, machen Sie sich mit den grundlegenden 
Konzepten der Software vertraut, indem Sie einige 
Funktionen mit den Demodaten auf der CD-ROM testen. 

Klicken Sie im Startmenü im Bereich "Lokaler Betrieb" 
(Offline Modes) auf "Gespeicherte Daten" (Recorded 
Data). Das Startmenü öffnen Sie über "Datei > FLUKE 
1760-Start Menü" (File > FLUKE 1760 Start Menu). 

 
g_emv06.bmp 

Navigieren Sie zur PQ Analyze-CD-ROM and wählen Sie 
eine der gespeicherten Messungen im Order "demo data" 
aus. 

 
g_emv07.bmp 
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Als Nächstes erscheint das Hauptanalysefenster. Dies ist 
der Ausgangspunkt für alle Messanalyseaktivitäten. Auf 
der linken Seite werden die "virtuellen Geräte" angezeigt 
und die verfügbaren Messdaten sind als blaue Balken 
dargestellt.  

Befolgen Sie zum Anzeigen eines Datentyps 6 einfache 
Schritte: 

1. Wählen Sie den Zeitraum aus, indem Sie die 
Cursormarkierungen mit der Maus verschieben. 

 
g_emv08.bmp 

 

 

2.  Wählen Sie auf der linken Seite das "virtuelle Gerät" 
aus. 

 
g_emv09.bmp 
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3. Wählen Sie die Messwertgruppe aus (Gruppe 
verwandter Messparamter). 

 
g_emv10.bmp 

4. Wählen Sie den Messwert aus. 

 
g_11.bmp 

5. Legen Sie die minimalen, mittleren und 
maximalen Werte aus. 

 
g_12.bmp 

6. Wählen Sie die Analysefunktion aus. 

 
g_13.bmp 
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Das Ergebnis erscheint in einem neuen Fenster.  

 
g_emv30.bmp 

Markieren Sie versuchsweise die Kontrollkästchen 
"halten" (hold) und "hinzufügen" (add), um Ihre Analyse 
permanent verfügbar zu machen bzw. verschiedene 
Messwerte in einem Fenster zu kombinieren und 
zuzuordnen. 

Dieses grundlegende Verfahren ist mit wenigen 
Ausnahmen auf alle Datenanalyseaktivitäten anwendbar. 
Je nachdem, welches virtuelle Gerät Sie auswählen, sind 
unterschiedliche Selektionen und Funktionen verfügbar. 

Kommunikation mit dem Recorder 
Wenn Sie mit dem grundlegenden Konzept der 
Datenanalyse vertraut sind, schließen Sie den Recorder 
an.  

Schließen Sie den Recorder an das Stromnetz an, 
schalten Sie ihn ein, schließen Sie einen 
Spannungssensor an Kanal 1 an und stellen Sie über das 
Ethernetkabel eine direkte Verbindung zwischen 
Netzwerkschnittstelle und dem PC her (gekreuztes RJ45-
Kabel mit roten Steckern). 

 
15.bmp 
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Wählen Sie im Menü "Datei > FLUKE 1760-Start Menü" 
(File > FLUKE 1760 Start Menu) und klicken Sie im 
Bereich "Online Betrieb" (Live Modes) auf "Setup". 

 
g_emv31.bmp 

 

Wenn auf Ihrem Computer mehrere 
Netzwerkschnittstellen installiert sind, wählen Sie aus 
dem Dropdown-Menü "Netzwerk" (Network) die 
entsprechende Schnittstelle aus. Klicken Sie im 
Dialogfeld "Geräte suchen" (Search Devices) auf 
"Suchen" (Search). 

 
g_17.bmp 
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In der Liste erscheint nur ein Eintrag (Ihr 
angeschlossener Recorder). Klicken Sie auf "Verbinden" 
(Connect). 

 
g_18.bmp 

Sie sind jetzt mit dem Recorder verbunden. Überprüfen 
Sie den Verbindungsstatus des Recorders in der rechten 
unteren Ecke des PQ Analyze-Fensters. 

 
g_emv32.bmp 

Das nächste Fenster enthält die Haupteinstellungen. Dies 
ist der Ausgangspunkt für alle Konfigurationen des 
Recorders. Behalten Sie vorerst die 
Standardeinstellungen bei und klicken Sie auf 
"Initialisieren" (Initialize). 

 
g_emv33.bmp 
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Wählen Sie einen Namen aus oder übernehmen Sie den 
Standardnamen. Klicken Sie auf "OK". 

 
g_20.bmp 

 

Warten Sie, während die Messung initialisiert wird. 

 
g_21.bmp 

Klicken Sie auf "OK" und beachten Sie die "RECORDING 
STATUS"-LED am Gerät. Sie müsste anfangen, langsam 
zu blinken, um die Messaktivität zu signalisieren. 

Schließen Sie das Fenster "Einstellungen" (Settings).  

 
g_22.bmp 

Die Messkampagne ist nun gestartet. 
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Anzeigen von Messdaten 
Nachdem die Verbindung erfolgreich hergestellt wurde 
und die Messkampagne gestartet wurde, fahren Sie mit 
dem Lesen einiger Messdaten fort. Die beste Methode, 
die an die Recorder-Eingänge geleiteten Signale zu 
überwachen, ist der "Online Modus" (Live Mode). Klicken 
Sie im Menü auf "Transfer > Online Modus" (Transfer > 
Live Mode) and "Oszilloskop" (Oscilloscope). 

 
g_24.bmp 

Wählen Sie Kanal 1 aus und klicken Sie auf das Symbol 
"Pegel-Zeit-Diagramm" (Timeplot). 

 
g_25.bmp 

 

 
g_55.bmp 

Wenn alles ordnungsgemäß funktioniert, sehen Sie 
Rauschen von den offenen Eingängen des 
Spannungssensors. 
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g_27.bmp 

Wenn die Messleitungen an den Netzstrom 
angeschlossen sind, erscheint eine Wellenform ähnlich 
dem Beispiel unten. 

Hinweis 

Befolgen Sie beim Anschließen von 
Messkreisen die Sicherheitsbestimmungen 
(siehe "Sicherheitsinformationen"). 

 
g_28.bmp 
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Mit dem "Zoom"-Werkzeug können Sie die Wellenform 
vergrößern. 

 
g_56.bmp 

 
g_29.bmp 

Nächste Schritte 
Sie kennen jetzt die grundlegenden Funktionen von Fluke 
1760 / PQ Analyze. Sie haben sichergestellt, dass Ihr 
Recorder ordnungsgemäß funktioniert, und sollten die 
erforderlichen Kenntnisse haben, um die komplizierteren 
Funktionen zu testen. 

Außerdem können Sie: 

• Messdaten von Ihrem Recorder auf den PC 
übertragen. 

• Die grundlegenden Geräteeinstellungen 
überprüfen/ändern (Uhrzeit und Zeitzonen, 
Gerätename). 

• Das Instrument mit einem LAN verbinden. 

• Die verschiedenen Möglichkeiten der 
Messkonfiguration testen. 

• Umfassende Berichte erstellen. 

PQ Analyze hat noch viele weitere Funktionen. Weitere 
Informationen finden Sie in den jeweiligen Abschnitten in 
der Dokumentation auf der CD-ROM. 
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